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Introduction

The Everglades Landscape Vegetation Succession model (ELVeS) is a spatially-explicit
simulation of vegetation community change over time in response to changes in environmental
conditions. The model uses empirically-based probabilistic functions of vegetation community
niche space and temporal lags to evaluate expected community response within the model’s
domain. The model has been parameterized for the Everglades spatial domain, including the
Water Conservation Areas and Everglades National Park.

ELVeS is written in Java as open source, freely distributed program executables and source code
to facilitate sharing, expansion and modification by a wide and diverse end user clientele.

Hardware Requirements

Operating System: Platform independent (tested on Ubuntu Linux and Windows XP)
CPU: 1GHz or faster

System Memory (RAM): 512MB or greater recommended

Hard Disk: 400MB free space

Software Requirements

Java JRE 1.5 or greater is required to run the Everglades Landscape Vegetation Succession
model.

Installation

There is no installer for the Everglades Landscape Vegetation Succession model. Simply unzip
the directory to the desired location.

Getting Started

All of the input and output files are CERP-compliant netCDF format. At the time of this writing,
CERP compliance was still being documented, however, CF-compliant netCDF is a documented
superset that will work with this software as well. Contact the authors for more information.
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The ELVeS model is parameterized via a graphical user interface (GUI). Parameters are saved
for inclusion in the model in an .xml file. Multiple .xml files can be created for running the
model under different conditions or for experimenting with parameters.

Running the Everglades Vegetation Succession Model

To run the Everglades Vegetation Succession model, navigate to the ELVeS directory.

In Windows, double click on ELVES.bat
or, at a Linux or Windows command line prompt, type: java -jar dist\ELVES.jar

When ELVeS starts, it will display the GUI. At the top of the GUI are two tabs, Setup and
Runtime. Setup has four tabs underneath it, Communities, Data Layers, Evaluation, and
Output.

To start the model using the default communities and parameters, click on File->Open, navigate
to the ELVeS folder and open the parameters_03302011 Default_ EDEN.xml file (accepts
EDEN hydrologic input) or the parameters_03302011_Default ECB3.xml file (accepts South
Florida Water Management Model ECB3 v.6.0 hydrologic input). When the parameter file is
loaded, go to the Setup—>Output dialog to rename the output file (if desired) and review the
other options.

Easting, Northing, X Max, Y Max, Cell Size, Start Date, and Time Max default to the values for
ECB3Stats.nc which is the default hydrological metrics input file. The Easting and Northing
values correspond to the upper left corner of the grid. The Start Date field represents the date
string in which the user wants output to start. Time Max is the number of years that are
simulated. X Max and Y Max are the number of cells in the x and y direction respectfully. Cell
Size is the size in meters of each cell.

Start Date and Time Max can be used to create an output subset of the input time sequence
instead of running every year. Be careful that the values used for Start Date and Time Max does
not exceed the range in the input file. Easting, Northing, X Max, and Y Max can be used to
spatially subset the output file. Cell Size can also be arbitrarily set to any output cell size (Caveat
Emptor).

The Notes text box is for remarks, sources, and any other comments that benefit the user by
keeping them with the parameter file. Anything typed into Notes is ignored by the application.

Clicking on the Run button will start model processing.
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P e
File Edit Help
Setup | Runtime
[ Communities T Data Layers T Evaluation T Qutput }
Path: ELVeS_ECB3_2_Apr_2011_21_16_27_GMT.nc | Browse |
I
|' Easting: 463200 KMax: 264 Cell Size(meters). 500
" Northing 2952000 | YMax 419 Notes
| stan Date(YYYY-MM-DD): | 1965-04-01 Parameters were generated from frequency histograms of each variable
under each community type defined with merged RECOVER-Florida GAP veg classification.
Time Max(years) 40 Hydrologic metrics from SFWMMW EBC3 v. 6.0
TP & LOl from interpolation of MNewman & Osborne soil survey data
Qutput archieved at BIOLAN Share1:#EcoModel/ELVeS/
(|
33% |__RunJ
Calculating instantaneous probabilities for 1 Apr 1966 05:00:00 GMT...

The communities modeled and their parameters can all be changed by the user by using the other
tabbed dialog boxes on the GUI (see the Modifying the Parameters section). If you experiment
with new parameters, Use File->Save As to save your changes to a new parameter file.

Mapped Outcomes

Two output files are created: a file of intermediate results before modeling temporal lags in
response and a file with the final ELVeS vegetation community outcomes that include

temporally-lagged responses. The output files are projected, spatially-explicit netCDF file format
containing annual time steps.

The first file contains all the intermediate results as multiple data layers that allow the user to
drill-down and examine the individual probabilities that result in the final mapped classification.
The first file is distinguished from the second by having “ iProb” appended to the file name.

The exact number of layers in the first file depends on the number of variables and number of
communities used in the model. There are 4 categories of data layers in the first file:
1. Conditional occurrence of each of the vegetation communities given each input
variable (number of data layers = number of communities x number of variables).
For each grid cell:
P(i| j) = Distribution _ Function _Value
where i = each of the vegetation communities and
J = each of the input variables

2. Joint instantaneous probabilities of occurrence of each of the vegetation
communities. Joint instantaneous probability of occurrence is the geometric mean
of the conditional occurrences for the vegetation community.

For each grid cell:
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P@i) = (P(i|j1) x P(i| j2) x P(i|j3) ... x P(i| jn))1/n
where i = each of the vegetation communities and
J = each of the input variables
n = number of input variables

3. The dominant predicted instantaneous vegetation community
For each grid cell:
For the set of community probabilities (P(i), i = 1 to n) select the
community with the highest probability.

4. The secondary predicted instantaneous vegetation community
For each grid cell:
For the set community probabilities (P(i), i = 1 to n) select the community
with the second highest probability.

The second file is a single data layer deep and contains mapped output of the dominant predicted
vegetation community when temporal lags are considered.

Model Description

ELVeS vegetation communities are evaluated against a probability distribution defined by the
user. There are currently four types of distributions supported by ELVeS, a normal, skewed
normal, logistic, and categorical distribution. At runtime, values are evaluated against the
corresponding distribution. After a cycle is complete, the individual probabilities are combined
via their geometric mean to give a total instantaneous probability of succession for a community
for that year. Temporal lags in community transition are then evaluated to produce a final
vegetation map.

Normal Distributions

Normal distributions are defined by the following equation:
Normal Rescaled

2 _(X_H)Z)/zcz 1.200
P(x) = 1/ sqrt(2nc®) * e
0.800 II \\
Where x is the random variable, | is the mean, and o is . Y
- - - : /
standard deviation defined by the user. 0200 ,/ -
0.000 T S
To rescale the distribution to vary between 0.0 and 1.0, a “KeuazB3z88°85
denominator is added that divides the above results by the Mean=440 StdDev-260
maximum value (value at x = p): = = Mean-440 stdDev-100

Y 50]”(27[0'2) * g~ () 20

P(X) 2 0/206?
1/sqrt(2zo°) *e
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Skewed Normal Distributions

Implementation of the skewed normal distribution is somewhat lengthier and the user is referred
to the source code for the equation set. There are 4 variables input by the user to define a skewed
normal distribution:

Location Determines shift of the distribution from the horizontal origin. If Shape=0,
then Location is equal to the mean of the distribution.

Scale Determines the statistical dispersion of the
distribution. If Scale is large the
distribution will be more spread out than if
Scale is small. If Shape=0, then Scale is
equal to the standard deviation of the
distribution. Scale must be a positive
number.

Shape Determines the asymmetry or skewness of
the distribution. A positive Shape skews the
distribution to the left of the mean (longer
tail on the right).

Max The maximum value of the skewed normal
distribution. Max is used to rescale the distribution to vary between 0.0 and
1.0.

Skewed Normal
Rescaled

Location=0.0 Scale=100. Shape=0

@ e e e location=0.0 Scale=100. Shape=4
Location=0.0 Scale=100. Shape=-4

One of the utilities distributed with ELVeS is the program, ELVeSkew, which provides
a “best fit” estimate of these four variables from user-provided frequency histogram
tables.

Logistic Distributions Logistic
1.2
Logistic distributions are defined by the following equation: | e
0.8 \\\‘
P(x) = 1/ (1 + ') 5
0.4 s
02 \\\
Where x is the random variable, p is the mean, and o is 0 B
standard deviation. RARINEBERSEEE235S
====S5tart=500 End=1200 Direction=-1
The function used in ELVeS is a transformation of the logistic Start=800 End=1000 Direction= 1

equation (Brandewinder 2008) that offers more intuitive
control over when growth happens and the rate of growth. The equation is:

a=In(1/PValuel-1)
b=(a-In(1/PValue2-1)/(End — Start)
P(X) — Peak /(1+e—b*(x—(a/b+8tart)))
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where:

Peak = maximum value that can be obtained = 1.0 (constant) for this application

Start = concentration (horizontal axis position) at start of logistic curve

End = concentration at end of logistic curve

PValuel = the proportion of the Peak that has been reached at a concentration of Meanl
PValue2 = the proportion of the Peak that has been reached at a concentration of Mean2
X = concentration at which the function is being evaluated

For this application,

If the Direction = 1, then the function is increasing and PValuel is 0.01 and PValue2 is
0.99

If the Direction = -1, then the function is decreasing and PValuel is 0.99 and PValue2 is
0.01

Therefore, only Start, End and Direction needs to be input.

Categorical Distributions

Categorical relationships provide the option of using non-continuous data categories. The routine
used in ELVeS needs the category numerical value and the probability of the community given
that category. Examples include nominal categories or continuous data that has been grouped as
interval categories as illustrated here:

Soil Type Category | Return Salinity Category | Return

Value Value Range Value Value
Marl 1 0.8 0.0-0.5 0 1.0
Sawgrass_Peat | 2 0.5 >05&<30 |1 0.4
Mangrove Peat | 3 0.0 >3.0 2 0.0
Sandy 4 0.5

Categories can also be used to create processing masks; that is, regions to exclude from
consideration. For example, Muhlenbergia Wet Prairie only occurs in the southern Everglades,
but Sawgrass is found throughout the Everglades, so a categorical mask for these two
communities might look like this:

MuhlenbergiaWetPrairie Sawgrass
Geographic | Category | Return Geographic | Category | Return
Area Value Value Area Value Value
North 0 0.0 North 0 1.0
South 1 1.0 South 1 1.0

These examples are to illustrate potential uses of the categorical option and are not meant to
represent actual parameters or parameter values used.
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Temporal Lags

When conditions favor a new community, temporal lags are expected to accompany the
transition from the existing vegetation community type to another. In the ELVeS model, the
existing vegetation community is not immediately replaced when a different community has a
higher probability of being at a location. If environmental conditions change such that the current
community’s probability of occurrence becomes low, it is increasingly likely to be replaced over
time. This results from a stochastic simulation that assigns an increasing probability that the
community will be replaced when there are an increasing number of years with low
instantaneous probability that the current vegetation community should be dominant.

Probability of replacement is defined independently for each community. The probability of
replacement determines how long the community retains dominance under unfavorable
conditions. For each contiguous year in which the existing community is not the favored
community, an index is incremented such that the index is equal to the previous year’s index
plus the proportional difference in the current year. The difference between the probability of the
favored community and the current community gives the proportional difference. The
probability of replacement is then determined by evaluating the index against a probability of
replacement curve. If the probability of replacement is greater than a randomly drawn number
from a uniform distribution, then the community is replaced. Otherwise, the existing community
is retained and the index value is carried forward to the next year where it is again incremented.

Temporal Lag Routine

JointInstantaneous Probabilities
at GridCell(x;y;) in Year,

classhave
highest

4 5 Keep Replace with Replace with
. probability

current class new “unclassified”
NG dominate
‘ No class

1‘»‘65

Other
classeswith Mo
higher r

" probabilities
T

Random

B e . Mumber>

. Pireplacement)
-~ y

P[replacement)

[ 1 2 E 4 s

disfavored Index

ELVeS uses an increasing logistic function to represent the probability of replacement
relationship. The index values at the start and end of the logistic curve are the parameterized for
each community. Because this is a stochastic process, the number of iterations is also an input
and the final outcome is taken to be the majority response from the repeated runs.
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Modifying the Parameters

The GUI dialogs and information that follow are not necessary to run the model if you are using
pre-defined parameters files and do not plan to change any of the communities or community
responses.

Communities

The Communities dialog contains a list of the communities to be modeled. Communities are
added to the list by typing their name into the entry box along the top of the form and clicking on
the Add button. Community names can be edited by double clicking on the name. Communities
can be deleted by selecting the community and clicking on the Remove button. Check boxes in
the Use column determine whether the community will be included in the model run.
Community names cannot contain spaces in this version of the model.

|| FLVeS 1.0.0a . (.= [l
File Edit Help
Setup | Runtime
| | communities | Data Layers | Evaluation | output |
Community: | Open Water] | Ada |
(|
Community Use
Spikerush @
Cattail ]
Open Marsh [}
Floating Emergent Marsh @
Muhlenbergia Wet Prairie ]
Mixed Marl Wet Prairie W
Mixed Marl Wet PraiieSawgrass )
Open Water @
= S
(G Remave
| Run |

The Use check boxes are also present in the Data Layers and Evaluation dialogs. They give the
user the opportunity to experiment with communities, data layers, and evaluations without
having to remove and redefine the lists for each trial. This method of parameterization is
particularly convenient in analysis of alternatives, where an analyst can simply define all data
layers and their evaluation in one step and include them as needed in their simulation.

Data Layers

The Data Layers dialog contains data layers that are to be used in the simulation. Input data
layer files contain the variables used by the model. All input files are CF-compliant netCDF
format. Currently (v1.0) ELVeS requires UTM, zone 17, NAD83, but that will not be a

requirement in future versions. Another temporary restriction on the netCDF files is that the

10
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eastings and northings must be labeled ‘x” and ‘y’ and time must be labeled ‘time’. The files do
not have to have the same cell sizes or origin.

Data Layers are added by browsing to the file and using the drop-down list of variables to select
the variable you want included. The same file can be used to select multiple variables, but they
must be added one at a time to the list. Check boxes in the Use column determine whether the
data layer will be included in the model run. Data layers cannot be edited because they are an
inherent property of the selected file, but they can be removed from the list by selecting the name
and clicking on the Remove button.

o =

File Edit Help

Setup | Runtime
Communities | DataLayers | Evaluation | Output |

File CUsersipearlstine EVERBIOLAN\Documents\Projects\ELVeSinputsimariMask3.nc | Browse |
Variable: | marlMask 'J | Add |
Layer Name File Path Use
meanAnnualDepthWet C\Users\pearistine. EVERBIOLAN\Documents\, ]
seventeenDayWaterDepthMin Ci\Users\pearlstine. EVERBIOLAN\D ocuments\. ]
seventeenDayWaterDepthMax C\Users\Ipearistine EVERBIOLAN\Documentst m
standardDeviationAnnualDepth Ci\Users\pearistine EVERBIOLAN\Documents\ ]
loi C\Users\pearistine. EVERBIOLAN\Documents\, ]
tp_krig C\Users\ipearistine. EVERBIOLAN\Documents\, ]
mariMask C\Users\Ipearistine EVERBIOLAN\Documentst m

| Remove |

| Run

The hydrologic metrics used in the ELVeS freshwater marsh component as input data
layers are annual metrics such as mean annual depth and 17-day running average
maximum depth. A utility supplied with the ELVeS modeling package, HydroMetrics,
can be used to generate these data layers from daily hydrologic outputs such as

SFWMM and EDEN.

Evaluation

There are five tabs under the Evaluation tab. The first four- Normal, Skewed Normal, Logistic,
and Categorical- define distributions that relate community response to each of the variables in
the data layers. The fifth, Simulation, sets the temporal lag response of each community.

Entering the response distribution parameters is similar for each of the distribution types. The
Skewed Normal dialog is shown below for illustration. At the top of the form, just below the
tabs, select the community and the data layer from the drop down lists. For the Skewed Normal
example, there are four parameters, Location, Scale, Shape, and Max, which the user supplies
values for. Clicking on the Add button, adds the parameters for that community/ data layer
combination to the list to be evaluated by the model. The user can then proceed to select

11
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additional community/ data layer combinations and enter their parameters for each of the
communities and data layers the model will evaluate. Normal, with 2 parameters, and Logistic,
with 3 parameters, work the same way.

File Edit Help
Setup | Runtime
[ Communities T Data Layers T Evaluation T Output W
Mormal | Skewed Normal T Logistic T Categorical T Simulation W
I Community: | Open Water 'J Data Layer: | seventeenDayWaterDepthMin 'J
Location:  199.33 Scale 50.00 Shape: -41.43 Max; U?Sl Add |
Community Datal ayer Location Scale Shape Max Use
Il | Mixed Marl Wet Pr meanAnnualDept 2746 100 1017 077 @ A
Sawagrass meanAnnualDept... 150 300 z 0.66 ] i
Open Water meanAnnualDept... 187.46 200 1017 0.76 W]
Spikerush seventeenDayWat 99.33 50 857 074 @
Cattail seventeenDayWat... 129.33 100 8.57 0.76 ]
Open Marsh seventeenDayWat... 229.33 100 -11.43 077 ]
Floating Emergen... seventeenDayWat... 209.33 50 -1.43 0.53 ] ]
Mublanbocaio \tet — ausctanaDaditel —_aznaa 1nn 44 an a7z [l
? | Remave |
Run |

Categorical has the same user input structure, except that the other distributions are expressed as
a single equation describing the continuous relationship between the data layer values and the
community response. The Categorical distribution divides the community response into discrete,
categories. When entering categorical parameters for a community, it is necessary to repeat each
community and data layer as many times as there are categories. In the example below, the
marlMask data layer has 2 categories with values of 0 and 1. For a community, parameters are
given for the first Category Value and for the Return Value (response) for that category value.
The same community is repeated to provide the Category Value and Return Value parameters for
the second Category Value.

File Edit Help

Setup | Runtime

[ Communities T Data Layers T Evaluation T Output W

[ Mormal T Skewed Normal T Logistic T Categorical T Simulation W

Community: | Open Water 'J Data Layer: | marlask 'J
I Category Value: 1 Return Value: 1.0 Add
Community Data Layer Category Value Use

Floating Emergent Marsh marlMask 0 1 @ Y
Floating Emergent Marsh marlMask 1 1 v
Muhlenbergia Wet Prairie marlMask 0 0 [}
Muhlenbergia Wet Prairie marlMask 1 1 @
Mixed Marl Wet Prairie marlMask 0 0 ]
Mixed Marl Wet Prairie marlMask 1 1 ]
Sawgrass marllask 0 1 v |
L2 Remove |

Run |

12
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Check boxes in the Use column determine whether the listed relationship will be included in the
model run.

Double clicking on any community in the list opens a dialog box for editing the parameter
values.

Skewed Normal Distribution Parametel l&,l
P
| | ELVeS — o o e
Community: | Spikerush 'J
File Edi
Setup || Data Layer: | seventeenDayWaterDepthMin ‘J
Comm|
Laocation: 99.33
Norma
Communl]| Scale: 50.0 enDayWaterDepthMin vJ I
Locatiorl Shape 8.57 | Add |
Commulf| Max 0.74 Shape Max Use
Wixed M 1017 077 ] i
Sawgra: &
Open W| | Accept | | Cancel | ||
- =
Cattail seventeenDayWat 12033 @
Open Marsh seventeenDayWat... 229.33 ]
Floating Emergen... seventesnDayWat... 209.33 50 -1.43 0.53 ] 3
Mblanbhacaio 1iat  couneteasPedliet —_ n7nan ann 44 an - f)
| 2 | Remove |
| Run |
Simulation

The Simulation tab sets the parameters for temporal lags in community response to change. The
temporal lag response is stochastic. The number of iterations to use is set by entering a value for
Iterations. Increasing the number of iterations may substantially increase processing time. Switch
Min and Switch Max are the starting and ending index values of the probability of replacement
curve along the horizontal axis. The Switch Min and Switch Max parameters are set
independently for each community type.

This version of ELVeS starts at year one of the simulation from a random distribution of
vegetation communities.

13
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e . W T o
File Edit Help
Setup | Runtime
[ Communities T Data Layers T Evaluation T Output W
[ Mormal T Skewed Normal T Logistic T Categorical T Simulation }
I lterations: 100 I
I Community: | Open Water _'J Switch Min:  0.001 Switch Max: | 4.5 Add
Community Min Max Use
Spikerush 0.001 45 ] i
Cattail 0.001 45 [}
Open Marsh 0.001 45 5]
Floating Emergent Marsh 0.001 45 W
Muhlenbergia Wet Prairie 0.001 45 E]
Mixed Marl Wet Prairie 0.001 45 @
Sawarass 0.001 45 =] v
| 2| | Remove |
| Run |
RunTime

The RunTime tab opens a dialog box that is currently not used. It may be used in the future to
provide additional information during model processing.

Mixed Models

Within any variable, some communities can be modeled with one distribution and other
communities with another distribution. For example, Sawgrass could have a normal distribution
in relation to phosphorous while Cattail has a logistic distribution.

Help

The Help menu item has four options: Contents, About, Report Bug, Send Comment.
Contents displays this document. About provides displays the Model and GUI version number.

Report Bug and Send Comment are quick ways to send us an email. This application is in its
first release and its use by a larger user group is the best way to discover what doesn’t work,
what could work better, and other comments that help us improve ELVeS. We have included
these options to encourage you to share your observations. Thank you.

14
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Viewing the Output

ELVeS ouput can be viewed and manipulated in any CF-compliant netCDF data tool
(http://www.unidata.ucar.edu/software/netcdf/software.html). A recommended Joint Ecosystem
Modeling (JEM) netCDF visualization application for south Florida is EverVIEW available at
http://www.jem.gov/Modeling/EverView.

ELVeS netCDF files can also be imported into ERSI ArcGIS. In ArcToolbox for ArcGIS
version 9.x, use Multidimension Tools—>Make NetCDF Raster Layer. After the file is loaded
in ArcGIS, right-click on the layer name in the Table of Contents and select Properties... and
select the NetCDF tab on the Layer Properties dialog that appears. From this dialog, you can
change the variable (if the file includes multiple variables) and time step of the data layer being
viewed. ArcGIS version 9.x has a limited capacity to load large netCDF files. Only the first date
from the time series may be available if the file has too many time intervals and layers. A work-
around is to subset the netCDF file into small enough time series to be within the capacity of
ArcGIS. The netCDF Slice and Dice tool is available from JEM for that purpose
(http://www.jem.gov/Modeling/SliceAndDice). ArcGIS version 10.x handling of netCDF files
has not been tested.
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ELVeS License

PUBLIC DOMAIN NOTICE, U.S. National Park Service

This software is a “United States Government Work” under the

terms of the United States Copyright Act. It was written as part of

the author’s official duties as a United States Government employee and
thus cannot be copyrighted. This software is freely available

to the public for use. The National Park Service and the U.S.
Government have not placed any restriction on its use or reproduction.

Although all reasonable efforts have been taken to ensure the accuracy

and reliability of the software and data, the National Park Service and

the U.S. Government do not and cannot warrant the performance or results
that may be obtained by using this software or data. The National Park
Service and the U.S. Government disclaim all warranties, express or implied,
including warranties of performance, merchantability or fitness for any
particular purpose.
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